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Chapter 1 Introduction
RTI® Launcher is a graphical application that allows you to install, configure, and run
RTI Connext® DDS components. It automatically detects which RTI components are installed and
enables their launch buttons, providing a convenient graphical interface to the configuration and
run-time parameters.

You can use Launcher to install new components or target platforms into the current RTI Connext
installation, see what is already installed, navigate to the documentation and web-based resources,
create new source-code projects (via its integration with rtiddsgen), and run all the RTI Connext
tools and command-line utilities.

Launcher is intended to be your “window” and “management console” for all your RTI Connext
products. Keep it handy and use it as the “launch” interface whenever you need to start any RTI
tool or service.

In addition, you can customize Launcher to run any program installed in your system, such as
third-party tools that work with RTI Core Libraries, or commonly used editors. This can be easily
done by changing the XML configuration file in the resource/app/app_support/launcher/panels
subdirectory of your Connext DDS installation directory.

1.1 Paths Mentioned in Documentation

The documentation refers to:

l <NDDSHOME>

This refers to the installation directory for RTI® Connext® DDS. The default installation
paths are:

l macOS® systems:
/Applications/rti_connext_dds-6.1.1

l Linux systems, non-root user:
/home/<your user name>/rti_connext_dds-6.1.1
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l Linux systems, root user:
/opt/rti_connext_dds-6.1.1

l Windows® systems, user without Administrator privileges:
<your home directory>\rti_connext_dds-6.1.1

l Windows systems, user with Administrator privileges:
C:\Program Files\rti_connext_dds-6.1.1

You may also see $NDDSHOME or%NDDSHOME%, which refers to an environment variable
set to the installation path.

Wherever you see <NDDSHOME> used in a path, replace it with your installation path.

Note for Windows Users:When using a command prompt to enter a command that includes the
path C:\Program Files (or any directory name that has a space), enclose the path in quotation
marks. For example:
“C:\Program Files\rti_connext_dds-6.1.1\bin\rtiddsgen”

Or if you have defined the NDDSHOME environment variable:
“%NDDSHOME%\bin\rtiddsgen”

l <path to examples>

By default, examples are copied into your home directory the first time you run RTI Launcher or
any script in <NDDSHOME>/bin. This document refers to the location of the copied examples as
<path to examples>.

Wherever you see <path to examples>, replace it with the appropriate path.

Default path to the examples:
l macOS systems: /Users/<your user name>/rti_workspace/6.1.1/examples

l Linux systems: /home/<your user name>/rti_workspace/6.1.1/examples

l Windows systems: <your Windows documents folder>\rti_workspace\6.1.1\examples

Where 'your Windows documents folder' depends on your version of Windows. For example,
on Windows 10, the folder is C:\Users\<your user name>\Documents.

Note: You can specify a different location for rti_workspace. You can also specify that you do not
want the examples copied to the workspace. For details, see Controlling Location for
RTI Workspace and Copying of Examples in the RTI Connext DDS Installation Guide.



Chapter 2 Using RTI Launcher
2.1 Starting Launcher

To start Launcher:

l On a Linux system:

You must have a graphical environment (such as X11, GNOME or KDE) running.
l Open a command prompt and navigate to the Connext DDS installation directory. Run
the script bin/rtilauncher.

l Alternatively, use your browser to navigate to your Connext DDS installation dir-
ectory’s bin directory and double-click rtilauncher.

l On a macOS system:

If you installed Connext DDS in the /Applications directory, the LaunchPad utility should
show RTI Launcher in the Connext DDS folder (rti_connext_dds-version). Click on it to
open Launcher.

l On a Windows system:

There are three ways to run RTI Launcher on a Windows system:
l In the Start menu under All Programs, find the entry called RTI Connext DDS <ver-
sion>. Underneath there you will see RTI Launcher <version>. Select it to start
Launcher.

l Use Windows Explorer to navigate to your Connext DDS installation directory’s bin
directory. For example, C:\Program Files\rti_connext_dds-version\bin. Double-
click rtilauncher.bat.

l From a command prompt, navigate to <NDDSHOME>/bin and run rtilauncher.bat.
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2.2 License Management

Launcher itself does not require a license file. However, some of the Connext DDS components may
require a license file. Launcher will aid you in making sure a license file can be found by these applic-
ations when started from Launcher. Launcher will look for the license file named rti_license.dat in three
locations in the order specified below:

l The path indicated by the RTI_LICENSE_FILE environment variable. The file does not need to
be called rti_license.dat to use this method.

l The RTI user home. This is the rti_workspace/version directory in the user’s home folder. The
specific location depends on the operating system.

l The Connext DDS installation directory. This is top-level directory where you installed the Con-
next DDS bundle.

For example, if a license-managed version of RTI Connext DDS Professional is installed in C:\Program
Files\rti_connext_dds-version on a Windows system and there is no RTI_LICENSE_FILE envir-
onment variable set, Launcher will first look for C:\Users\your user name\Documents\rti_
workspace\version\rti_license.dat (RTI user home). Then, if not found, it will look for C:\Program
Files\ rti_connext_dds-version\rti_license.dat.

2.2.1 Setting the License File

Some of Launcher’s tools may be license-managed. In this case, if Launcher has no knowledge of a valid
license file, those tools will be grayed out and won’t work until a valid license is provided. A warning mes-
sage will be shown to indicate that the license file can not be found.

When you have a valid license, there are a few ways to tell Launcher about the license file:

l Use the Launcher Configuration tab’s Choose button. This will open a file chooser dialog that will
let you navigate to the license file. After choosing the file, Launcher will prompt you with the fol-
lowing dialog:



2.2.1  Setting the License File

You have three choices:
o Copy to RTI install location (all users): The chosen license file will be copied to the Con-
next DDS installation directory, with the name rti_license.dat. Launcher will use this license
file not only for the current execution and the current user, but for subsequent executions by
any user in the system with access to the RTI Core Libraries installation. Note that if you
have installed into a system directory, selecting this option may require system privileges.

o Copy to RTI user home (just for user <user>): The chosen license file will be copied to the
current user’s rti_workspace/<version> directory. The license file will thus only be visible
for the current user in subsequent executions of Launcher.

o Skip: The chosen license file will be applied by Launcher only for the current execution of
the tool. It will not be automatically detected by the tool in subsequent executions.

l Copy the file manually to one of the aforementioned locations where Launcher will search by
default, and name the file rti_license.dat. As mentioned before, if the RTI license file is copied to
the RTI user home, it will only be visible for this user in subsequent executions of the tool. When
the file is copied to the RTI install location directly, it will be visible for all users with access to that
directory.

The file may be copied both when Launcher has already been started or when it is offline. If the
license file is copied while Launcher is executing, Launcher will detect the change automatically
and apply the license to the UI.
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l Set the RTI_LICENSE_FILE environment variable with the path to the license file. When setting
this variable, not only Launcher but all the RTI applications will use the license file environment
variable when executing.

Notice that when copied to one of the known locations, all RTI applications will also detect the
license file.

After successfully setting a license file with Launcher, all the tools that were disabled because of the
license will become available and usable.

2.3 Launcher’s Tabs

Launcher has a Graphical User Interface with tabs for different application categories. The contents of the
tabs are XML-defined. If a tab contains no entries (buttons), or none of the applications in a tab are sup-
ported on your platform, that tab will not appear in Launcher.

There are five tabs that are always visible to the user:

l 2.3.1 Learn Tab on page 9

l 2.3.2 Tools Tab on page 9

l 2.3.3 Services Tab on page 10

l 2.3.4 Utilities Tab on page 14

l 2.3.5 Configuration Tab on page 17

Launcher also includes other tabs, which may or may not be visible.

l 2.3.6 What's New Tab on page 18

l 2.3.7 Next Gen. E/E / ADAS Tab on page 19

l 2.3.8 Telematics Tab on page 20

l 2.3.9 Simulation Tab on page 21

l 2.3.10 Labs Tab on page 22

l 2.3.11 Ecosystem Tab on page 22

l 2.3.12 User Tab on page 23

Note: All the tabs may or may not be visible if Launcher cannot find the resources needed to create the
tab. For instance, if the tools folder is missing—or if there is a tools folder but no buttons configured inside
it—there will be no Tools tab. See 3.1 Launcher Tabs and Their Associated XML Files on page 29 for
details. You can also add new tabs to Launcher. See 3.5 Example: Adding a Tab to Launcher on page 36.



2.3 Launcher’s Tabs

To start one of the applications in a tab, click on the application’s button. Some applications will launch dir-
ectly, such as RTI Admin Console. Other applications, like the ones in the Services or Utilities tab, will
pop-up an application-specific dialog. This dialog allows you to configure the settings to run the applic-
ation and then execute it.

Right-clicking (or Command-Click on macOS systems) a button will open a context menu with additional
information and options:

The context menu may vary for every tool, but in general, the options are:

l Install/Uninstall: This option installs the tool if it is not yet installed, or uninstalls it if it is already
installed.

l View command history: Launcher keeps track of all the successful command executions in the cur-
rent Launcher session. When you click this menu item, it will open up the application’s Command
History dialog, which shows the command that was executed, when it was launched, and the work-
ing directory from where it was launched:

l Command help: Some applications provide usage notes regarding calling parameters (services, util-
ities, etc.). For those applications, this menu will show the available options. For example:
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l Documentation: These options link to official RTI documentation for the tool, with the format:
Document Name (Format (PDF or HTML), Location (local or on-line)).

If a tool is not installed or cannot be used (due to an expired license, for instance), a different icon will
appear and the button will not work.

Launcher automatically detects the presence of the applications in various ways. In the majority of cases,
Launcher looks for installed applications in <NDDSHOME>/bin. For other applications, it looks in the
Windows Registry. On Linux systems, Wireshark is found by using the UNIX which command.

Not all tools are available on all platforms. For example, RTI Spreadsheet Add-in for Microsoft Excel is
only available on Windows systems. On non-Windows systems, its button still appears but will not work.

Note: Some applications in Launcher open a command prompt terminal. Whenever Launcher opens a
command prompt terminal, it removes the content of the following environmental variables in order to suc-
cessfully open some services:

l LD_LIBRARY_PATH on Linux systems

l DYLD_LIBRARY_PATH on macOS systems



2.3.1  Learn Tab

2.3.1 Learn Tab

The Learn tab contains a broad range of technical resources to learn about the RTI Connext DDS product
line and its underlying Object Management Group (OMG) Data Distribution Service (DDS) technology.
The Learn tab includes the following:

l Shapes Demo demonstrates Connext DDS capabilities by publishing and subscribing to colored
moving shapes.

l Resources contains some useful resources to links to learn about DDS technology.

2.3.2 Tools Tab

The Tools tab contains applications that can be run directly, without requiring any additional application-
specific setup. The Tools tab includes the following applications:

l Admin Console is a centralized tool for administering, supervising, and visualizing your distributed
system. It provides control over RTI services such as RTI Routing Service and RTI Recording Ser-
vice, offers a centralized way to receive and view log messages, detects configuration errors includ-
ing type and QoS mismatches, and visualizes data. You can subscribe to the topics in the system to
see the data being published in real time.

l Monitor provides a graphical view to the internal configuration and operation of Connext DDS
applications, including QoS and detailed statistics on connections, traffic, errors, and resource usage.
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l System Designer is a graphical tool that allows you to define and configure Connext DDS systems.
You can use it as a user interface to XML-Based Application Creation, a mechanism that allows
you to specify all aspects of a Connext DDS system in XML format.

l Wireshark is a network packet analyzer. It can view and capture data packets in an RTI network,
dissect them, and graph the output for easy analysis.

l Spreadsheet Add-in for Microsoft Excel® can read and write data fromMicrosoft Excel spread-
sheets. It updates the Excel data in real-time and can perform computations or create graphics with
the data.

2.3.3 Services Tab

The Services tab provides buttons and dialogs to run RTI infrastructure services that require application-
specific setup. The Services tab includes the following applications:

l Routing Service integrates disparate and geographically dispersed systems. It scales Connext DDS
applications across domains, LANs and WANs, including firewall and NAT traversal. It also sup-
ports Connext DDS-to-Connext DDS bridging by allowing you to make transformations in the data
along the way.

l Recording Service records real-time data without having prior knowledge of the data-types or top-
ics in the system. (This service is also available by using Recording Console in the Tools tab.)

l Replay Service replays recorded data by injecting it back into DDS. You can change data rates and
QoS settings. (This service is also available by using Recording Console in the Tools tab.)



2.3.3  Services Tab

l Persistence Service saves data from Connext DDS publishing applications to memory or permanent
storage, so it can be delivered to subscribing applications that join the system at a later time—even if
the publishing application has already terminated. Data can be persisted to files or an external data-
base.

l Database Integration Service provides bidirectional integration between Connext DDS and a data-
base (PostgreSQL or MySQL).

l Queuing Service provides a queue (exactly-once) communication pattern in which each sample will
be delivered to exactly one QueueConsumer. If there are no QueueConsumers available when the
sample is sent, the sample will be stored until a QueueConsumer is available to process the sample.
This pattern is very useful in load-balancing applications.

l Web Integration Service provides a simple, generic, standards-based interface that provides a trans-
parent bridge between web-based services (HTTP/HTTPS) and unmodified Connext DDS applic-
ations.

l Cloud Discovery Service is a stand-alone application that is needed when deploying Connext DDS
applications in dynamic environments where UDP/IP multicast is not available.

Dialogs in the Services and Utilities tabs also include validation for wrong parameters or paths. Text fields
are highlighted with different colors depending on their validation status:

l Green indicates that the field has a valid entry.

l Yellow indicates that the information is missing, but not required.

l Red means the field contains invalid values (for example, a missing file).
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Hover over the warning icon to see an explanation of why the dialog is invalid.

When you are done configuring the service, click on the Run button to run the service. If the dialog has
some invalid entries, the Run button will be disabled and a warning icon will appear next to it.

Note: The Run button will be available if at least one configuration file is valid. Launcher validates all the
inputs again when you click on the Run button.



2.3.3  Services Tab

If you want to preview the command that will be used for execution, check the Confirm command check-
box. If the checkbox is checked, the name of the Run button will change to Check. If you click on
Check, a pop-up dialog will show the command and command-line options that will be used and the work-
ing directory from which the command will be run.

The command-line options map to the fields you entered in the previous dialog (for example, the
RTI Routing Service dialog above). You can add new command-line options or remove existing ones. See
the service's documentation for more information about its full set of command-line options.

If the execution is successful, this command will be stored in the Command History of the service. See 2.3
Launcher’s Tabs on page 6 for more about viewing command history.

For dialogs that have a Target field, Launcher runs the executable for the selected target. The choices for
this field depend on which target bundles you have installed. The default value for this field is:

l x64Linux2.6gcc4.4.5 for Linux systems

l x64Darwin17clang9.0 for macOS systems

l x64Win64VS2012 for Windows systems

To change the default Target value, either:

l Edit the file $NDDSHOME/resource/scripts/rticommon_config to add your selected platform to
connextdds_architecture (on Linux and macOS systems) or connextddsArchitecture (on Win-
dows systems).

l Or set the CONNEXTDDS_ARCH environmental variable to your selected target architecture.

Note. The value set in the rticommon_config file takes precedence over the environmental variable.
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2.3.4 Utilities Tab

The Utilities tab contains helper applications provided with Connext DDS to assist you when testing,
designing, or inspecting your DDS system.

l Code Generator, also known as rtiddsgen, generates the code to serialize and deserialize applic-
ation data on the wire from an IDL (or XML) description of the data-type. It also generates example
code and makefiles/project files so you can quickly build a working application.

l DDS Ping, also known as rtiddsping, publishes (and subscribes to) DDS ping messages to test sys-
tem connectivity.

l DDS Spy, also known as rtiddsspy, can subscribe to any DDS Topic and print out all the data being
published.

l Data Type Convert converts data-type formats between IDL and XML.

l Record Database Converter converts database files recorded by Recorder into readable, com-
monly accepted formats such as CSV, XML, and HTML.

l Connext DDS Professional Terminal opens a terminal window configured with the environment
variables necessary for building Connext DDS Professional and Connext DDS Secure applications.

l Connext DDS Micro Terminal opens a terminal window configured with the environment vari-
ables necessary for building Connext DDS Micro and Connext DDS Micro Secure applications.

l Perftestmeasures the Latency and Throughput of very configurable scenarios that use Connext
DDS to send messages.

l Connector for Python® provides an easy way to write applications that publish and subscribe to
the Connext DDS databus in Python and other languages.

l Connector for JavaScript® provides an easy way to write applications that publish and subscribe
to the Connext DDS databus in JavaScript and other languages.



2.3.4  Utilities Tab

When you click on a utility button, a configuration dialog will pop up. Every utility has a different dialog,
customized for its own needs. For example, the Code Generator dialog looks like this:
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The Code Generator dialog can generate code for Connext DDS Professional or Connext DDS Micro.
When Connext DDS Micro is selected in the SDK drop-down menu, options that are not supported for
Connext DDS Micro will be disabled, and -micro will be added to the command-line options. You can see
the command line by selecting the Confirm command checkbox and clicking Check.



2.3.5  Configuration Tab

2.3.5 Configuration Tab

The Configuration tab provides general information regarding the current Connext DDS installation. This
tab:

l Displays the current installation directory for Connext DDS.

l Displays the license file and allows changes to its location. A license may not be necessary depend-
ing on the bundle installed. Launcher detects the need for a license file on a per-product basis.

l Displays a table with the installed products and libraries, and their installed versions. This table can
be filtered by using the filter field. The table can also be fully expanded/collapsed by using the two
buttons next to the filter field.

l Provides access to the RTI Package Installer through the Install RTI Packages button, to install
additional components and libraries into an existing Connext DDS installation.

l Provides access to the RTI Support website via the Download RTI Packages button.

l Provides access to the Preferences dialog.
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2.3.5.1 Preferences Dialog

This dialog is used to configure general settings in Launcher:

l Hide or show the What's New tab.

l "Work online" means that Launcher will get the latest blog posts or news from the RTI Website
when displaying the What's New tab. Disabling this option means Launcher will use local content
that was stored when you last accessed the internet (when you downloaded the current release, or
the last time the buttons were clicked and the content was stored from the internet). The local con-
tent is stored in rti_workspace/version/user_config/launcher/rss.

The Preferences settings are stored in the file launcher.properties, in rti_workspace/version/user_con-
fig/launcher.

2.3.6 What's New Tab

The What's New tab includes three different buttons used to configure the content of this tab:

l What's New shows a brief summary of the new features in the current version of RTI Connext DDS
Professional.

l News shows the latest news from https://www.rti.com/news.

l Blogs shows the latest blog posts from https://www.rti.com/blog.

This tab requires an internet connection to show the latest news and blog posts from the RTI website.
Launcher updates this content each time the buttons are clicked, as long as "Work online" is checked in
the Preferences dialog. See 2.3.5.1 Preferences Dialog above for more information.

https://www.rti.com/news
https://www.rti.com/blog


2.3.7  Next Gen. E/E / ADAS Tab

Note: You can hide this tab by unchecking the option "Show What's New tab" in the Preferences dialog.
You can also configure Launcher to not require an internet connection by unchecking the option "Work
online." See 2.3.5.1 Preferences Dialog on the previous page for more information on these options.

2.3.7 Next Gen. E/E / ADAS Tab

The Next Gen. E/E / ADAS tab provides utilities for Next Gen. EE and ADAS use cases. The Next Gen.
E/E / ADAS tab is only visible when Connext Drive is installed. It includes the following applications:

l Code Generator for Micro, also known as rtiddsgen, generates the code for Connext DDS Micro
2.4.14 to serialize and deserialize application data on the wire from an IDL (or XML) description of
the data-type. It also generates example code and makefiles/project files so you can quickly build a
working application.

l Copy Connext DDS Micro SDK copies the Connext DDSMicro SDK (source code + code gen-
erator) to a specified directory. The context menu also allows you to copy any version of Connext
DDS Micro that has been installed, or to copy the source path of any version of Connext DDS
Micro (the path where the SDK was copied, or the original folder if the SDK has never been
copied).

l Code Generator for Cert, also known as rtiddsgen, generates the code for Connext DDS Cert
2.4.12.1 to serialize and deserialize application data on the wire from an IDL (or XML) description
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of the data-type. It also generates example code and makefiles/project files so you can quickly build
a working application. By default, this button will be disabled until the Cert package is installed.

2.3.8 Telematics Tab

The Telematics tab provides utilities for telematics use cases. The Telematics tab is only visible in Drive
and includes the following applications:

l Code Generator, also known as rtiddsgen, generates the code to serialize and deserialize applic-
ation data on the wire from an IDL (or XML) description of the data-type. It also generates example
code and makefiles/project files so you can quickly build a working application.

l Routing Service integrates disparate and geographically dispersed systems. It scales Connext DDS
applications across domains, LANs and WANs, including firewall and NAT traversal. It also sup-
ports Connext DDS-to-Connext DDS bridging by allowing you to make transformations in the data
along the way.

l Web Integration Service is a simple, generic, standards-based interface that provides a transparent
bridge between web-based services (HTTP/HTTPS) and unmodified Connext DDS applications.

l Cloud Discovery Service is a standalone application that is used to deploy Connext DDS applic-
ations in dynamic environments where UDP/IP multicast is not available.



2.3.9  Simulation Tab

2.3.9 Simulation Tab

The Simulation tab provides utilities, services and ecosystems fitting Simulation use cases needs. The Sim-
ulation tab is only visible in Drive and includes the following applications:

l Recording Service records real-time data without having prior knowledge of the data-types or top-
ics in the system. (This service is also available by using Recording Console in the Tools tab.)

l Replay Service replays recorded data by injecting it back into DDS. You can change data rates and
QoS settings. (This service is also available by using the Recording Console in the Tools tab.)

l Routing Service integrates disparate and geographically dispersed systems. It scales Connext DDS
applications across domains, LANs and WANs, including firewall and NAT traversal. It also sup-
ports Connext DDS-to-Connext DDS bridging by allowing you to make transformations in the data
along the way.

l Code Generator, also known as rtiddsgen, generates the code to serialize and deserialize applic-
ation data on the wire from an IDL (or XML) description of the data-type. It also generates example
code and makefiles/project files so you can quickly build a working application.

l RTI DDS Toolkit for NI® LabVIEW® provides VI blocks that allow you to easily publish and
share data between multiple LabVIEW applications, NI Linux Real-Time controllers and third-party
applications that use DDS.

l DDS Blockset for MathWorks® provides apps and blocks for modeling and simulating software
applications that publish or subscribe to Data Distribution Service (DDS) using RTI Connext DDS.
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2.3.10 Labs Tab

This tab is reserved for RTI applications that are experimental. It may be empty in some releases and there-
fore not shown at all.

The XML files that define this tab are in the RTI workspace in your home folder:
rti_workspace/<version>/user_config/launcher/panels/labs/.

You can find experimental applications on our Community Portal (https://community.rti.com). Visit it and
download the new applications. Most of them will also provide XML snippets to be added to the
Launcher configuration file that will allow you to run the new applications from Launcher just as you can
run the other Connext DDS applications.

2.3.11 Ecosystem Tab

This tab is reserved for applications from RTI’s partners. For information about RTI’s strategic partners,
see the RTI Partners website: https://www.rti.com/partners. This tab may be empty in some releases and
therefore not shown at all.

Products downloaded by using the Ecosystem tab in RTI Launcher are not part of RTI and you should con-
tact the third-party provider for more information about them.

https://community.rti.com/


2.3.12  User Tab

2.3.12 User Tab

The User tab is reserved for customizing Launcher. Its purpose is to allow users to integrate their preferred
applications in Launcher. The User tab is not visible the first time Launcher is run, because it’s empty by
default, and Launcher doesn’t show tabs that are empty. The folder that defines this tab is in the RTI work-
space in your home folder: rti_workspace/version/user_config/launcher/panels/user. Inside this folder,
you will find two files:

l configuration.xml: used to configure the name of the tab, add a description to the tab, and alter the
order of the buttons.

l example.xml: used to add a shortcut button to any application in the system.
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You can modify the user folder to add shortcuts for any application in the system. See Chapter 3 Con-
figuring Launcher on page 29 for more details on how to do this.

2.4 Help

By default, the help content, which includes links to documentation and other information such as the RTI
Support Portal and RTI Community website, is shown. Each tab has a button in the upper right hand
corner which is used to show or hide the help content.



2.5 Installing Target Libraries and RTI Components

The Browse Offline link opens the root of the documentation folder in your Connext DDS installation dir-
ectory. Links to specific guides and API references also open those documents in the installation directory.

2.5 Installing Target Libraries and RTI Components

Launcher uses the RTI Package Installer to install new libraries and components. The Package Installer
accepts files in RTIPKG format (*.rtipkg). RTI’s target libraries and add-on components are available in
this RTIPKG format when downloaded from the RTI download portal.

The RTI Package Installer executable is in the Connext DDS installation directory, in the bin directory. It
can also be executed from the command-line prompt.

In Launcher, the RTI Package Installer is in the Configuration tab. When you click on it, a dialog will pop
up, like this:

25
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At this point, select the RTIPKG files to be installed. If you click on the ‘+’ button, a file chooser dialog
will appear, allowing you to navigate to the file(s) you want to install. You can also drag and drop .rtipkg
files into this window.

Once the files are selected, click the Install button. The install commands are launched sequentially. A pro-
gress dialog will appear:

Note: The drag and drop feature won't work if you opened Launcher as an administrator on a Windows
system.



2.6 Troubleshooting with Launcher

2.6 Troubleshooting with Launcher

Launcher provides two debugging or troubleshooting mechanisms:

l Log view: Launcher produces log messages when it performs an action, an error occurs, etc. You
can access these log messages from any of the tabs by clicking on the expandable ‘Log’ view.
When clicked, the view will expand and show all the messages produced up to that point:
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l Log files: Launcher logs output and errors to files in a special directory. This directory can be found
in the user home’s RTI workspace directory: rti_workspace/<version>/user_
config/launcher/logs. Launcher’s execution log files are named with the following pattern:
launcher-log-<timestamp>.txt. Every execution of Launcher creates a different log file.

For applications not launched in command-prompt windows—like the applications in the Tools tab—
Launcher also logs their output into text files for application troubleshooting. These files are stored in the
same place as the Launcher logs (rti_workspace/version/user_config/launcher/logs). They are named
following this pattern: log-<executable name>-<timestamp>.out.



Chapter 3 Configuring Launcher
3.1 Launcher Tabs and Their Associated XML Files

Launcher’s tabs are defined using XML inside a folder. There is a folder for each tab. Each folder
contains an XML file for each button and an optional configuration file that is used to configure:

l The name of the tab;

l The position of the tab;

l If the tab is selected;

l The content of the tab (up to two sub-panels can be defined inside a tab), including:
l The description of the tab;

l The order of the buttons.

The buttons available on each tab are defined in the RTI Connext DDS directory, in
<NDDSHOME>/resource/app/app_support/launcher/buttons. These are predefined XML
files. You should not modify the predefined XML files except the configuration file (con-
figuration.xml), which is used to configure the order of the buttons in a tab. The configuration
XML files are in the RTI Connext DDS installation directory, in <NDDSHOME>/re-
source/app/app_support/launcher/panels. They configure the following tabs:

l Learn

l Tools

l Services

l Utilities

l Ecosystem

l Next Gen. E/E / ADAS (only if Connext Drive is installed)

29



3.1.1  Configuration file

30

l Telematics (only if Connext Drive is installed)

l Simulation (only if Connext Drive is installed)

There are other Launcher configuration files that are intended to be customized by users. You will find
these files in your RTI workspace1: rti_workspace/<version>/user_config/launcher/panels directory.
You can use these files to configure the following tabs:

l Labs

l User (see 3.4 Example: Adding a Button to Launcher’s User Panel on page 34)

Note: The buttons used by these tabs must be defined inside that tab's folder.

Note: You can add more tabs to Launcher. See 3.5 Example: Adding a Tab to Launcher on page 36 for
more information.

3.1.1 Configuration file

The configuration file is an optional file used to configure the following content in each tab:

1See 1.1 Paths Mentioned in Documentation on page 1.



3.1.1  Configuration file

l Name of the tab: If not specified, Launcher will use the name of the folder.

<name>Services</name>

l Position of the tab: If not specified, Launcher will add the tab at the end before the Configuration
Tab. If two tabs share the same position, Launcher will report a warning in the Log view and will
add those tabs sharing the same position at the end before the Configuration Tab.

<index>3</index>

l Whether the tab is selected at startup: If specified, Launcher will select the tab at startup if the
License File has been set in the Configuration tab, otherwise the Configuration tab will be selected
at startup. If multiple tabs are configured to be selected, Launcher will select the tab closest to the
Configuration tab.

<selected>true</selected>

l Panel configuration: The <panel> tag describes what will be displayed in the tab that is configured
by the current configuration file. Up to two sub-panels can be defined inside a tab. The following
shows how to configure a tab into two sub-panels, as seen in the following screenshot:
<panel>

<element>
<description>

<element>
<message>

Tools for developing and debugging Connext applications
</message>

</element>
</description>
<order>

<name>AdminConsole.xml</name>
<name>Monitor.xml</name>
<name>SystemDesigner.xml</name>

</order>
</element>
<element>

<description>
<element>

<message>
Tools for developing and debugging Connext applications

</message>
</element>

</description>
<order>

<name>Wireshark.xml</name>
</order>

</element>
</panel>
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Note: Scrolling is disabled when splitting a tab into sub-panels.

l Description of the tab: Displayed at the beginning of each tab. The description can be plain text or
a link to any resource, such as a PDF or website. The following shows how the Learn tab has been
configured to show its description:
<description>

<element>
<message>Resources for: </message>

</element>
<element>

<message>Getting Started with Connext DDS</message>
<link>manuals/connext_dds_professional/getting_started_guide/cpp11/RTI_

ConnextDDS_GettingStarted_cpp11.pdf</link>
</element>

</description>

The following description has two parts, both plain text; however, the second one is also a link to
the RTI Connext DDS Getting Started Guide:

l Organization of buttons in the tab: If not specified, the buttons will be organized alphabetically
by name. To organize the buttons, specify the name of the file and not the name of the button itself.
You can modify the configuration file of all the tabs in Launcher to reorganize the buttons.



3.2 How Launcher Finds Images

<order>
<name>RoutingService.xml</name>
<name>RecordingService.xml</name>
<name>ReplayService.xml</name>
<name>PersistenceService.xml</name>
<name>DataBaseIntegration.xml</name>
<name>QueuingService.xml</name>
<name>WebIntegrationService.xml</name>

</order>

For example: consider two buttons in the user tab, Eclipse.xml and Notepad.xml. Launcher adds
first the Eclipse button and then the Notepad button, alphabetically by name. If you rename the file
Eclipse.xml to Z.xml, however, the first button will now be the Notepad button (Eclipse will be the
second button). Alternatively, use the <order> tag to explicitly choose the order of the buttons.

Note: Launcher still supports having a description of the tab and the organization of the buttons out-
side the <panel> element in XML. The following configuration is still valid:
<configuration>

<name>Services</name>
<index>3</index>
<description>

<element>
<message>Connext Services for routing, recording, and integrating with other

components</message>
</element>

</description>
<order>

<name>RoutingService.xml</name>
<name>RecordingService.xml</name>
<name>ReplayService.xml</name>
<name>PersistenceService.xml</name>
<name>DataBaseIntegration.xml</name>
<name>QueuingService.xml</name>
<name>WebIntegrationService.xml</name>
<name>CloudDiscoveryService.xml</name>

</order>
</configuration>

3.2 How Launcher Finds Images

Launcher looks for the image files to be shown for the applications in the following places:

l In the Connext DDS installation directory, in <NDDSHOME>/resource/app/app_sup-
port/launcher/icons. This folder is used for RTI-related applications and applications by RTI’s part-
ners (shown in the Ecosystem tab).

l In your RTI workspace directory, under rti_workspace/version/user_config/launcher/icons. This
folder may not exist after installing and first running the tool. To add user-related images, you have
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to create this folder and add your icon image files there.

l Absolute paths. Launcher can detect files described as an absolute path to the image.

3.3 How Launcher Finds Buttons

The buttons that Launcher displays (in any tab) must be in either of these locations:

l In the Connext DDS installation directory, in <NDDSHOME>/resource/app/app_sup-
port/launcher/buttons. This folder is used for applications from RTI and RTI’s partners (shown in
the Ecosystem tab).

l In your RTI workspace directory, under each panel. For example, rti_workspace/version/user_
config/launcher/panels/user.

3.4 Example: Adding a Button to Launcher’s User Panel

The User tab is not visible the first time you run Launcher, because it’s empty by default and Launcher
doesn’t show tabs that are empty. This tab is intended to be configured by the user.

This section shows how to add a button to the User tab’s XML file so that it appears in Launcher. We’ll
use the Eclipse development environment as an example:

The User tab is defined in the user folder found in the Launcher configuration folder in the user home’s
RTI workspace. Inside this folder are two files, configuration.xml and example.xml.

The first time you open example.xml, it contains:
<?xml version="1.0" encoding="UTF-8"?>
<launcher xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"



3.4 Example: Adding a Button to Launcher’s User Panel

xsi:noNamespaceSchemaLocation="launcher_panel.xsd">
<!-- Add a custom menu item here -->

</launcher>

You can change the name of the file example.xml; however, take into account that by default Launcher
uses the name of the files to organize the buttons in the Tab alphabetically (each file represents a button).
You can also reorganize the buttons using the configuration file as explained in 3.1 Launcher Tabs and
Their Associated XML Files on page 29.

All the tab/panel configuration files start with the XML tag <launcher>. Let’s add a button for running
Eclipse to the user panel definition. Buttons are defined in a tag called <button>:
<?xml version="1.0" encoding="UTF-8"?>
<launcher xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xsi:noNamespaceSchemaLocation="launcher_panel.xsd">
<!-- Add a custom menu item here -->
<button name="eclipse">

<icon>eclipse256.png</icon>
<tooltip>Eclipse:

Eclipse Development Environment.
</tooltip>
<legend>Eclipse</legend>
<toolexec>C:\Eclipse\eclipse.exe</toolexec>
<popupmenu>
</popupmenu>

</button>
</launcher>

This is how the different tags are interpreted by Launcher:

l ‘name’ attribute: Internal name of the button. No specific rule for it.

l icon: Path or name of the icon file that will be used to show the application in the panel. Preferred
image file formats for Launcher are PNG and GIF (Launcher may not be able to correctly render
the file if another format is provided, e.g., vectorial). It can contain an absolute path to the file, or it
can refer to the name of the file, in which case the image file will be looked for in one of the image
locations discussed in 3.2 How Launcher Finds Images on page 33. In our case, we copied the
eclipse 256 logo file (eclipse256.png) into rti_workspace/<version>/user_config/launcher/icons.
If the icons sub-directory doesn’t exist, it can just be created normally.

l tool-tip: Required field. It is used to define a title for the application and a brief description. This
information will be shown to the user as a balloon tool-tip when hovering over the icon. The format
of this field must be: {Title}:{Description} (the ‘:’ is necessary; Launcher may fail to create the
panel if not found).

l legend: Title for the tool that will be shown right below the icon.

l toolexec: Path to the executable to run when the user clicks on the application icon.
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l popupmenu: Required field, needs to be present, but it may be empty, like in our example. This tag
is used to describe entries in the context menu that will be shown when the user right-clicks on the
icon.

Once the example.xml file has been modified and saved, restart or start Launcher for the changes to take
effect. You should be able to see the User tab now, and in it there will be a launch button for the Eclipse
Development Environment.

Launcher’s XML format for panels is described in the XSD file launcher_panel.xsd. This file is located
in the same directory as the user folder and labs folder (rti_workspace/version/user_con-
fig/launcher/panels). This file provides complete reference for defining buttons for Launcher in XML.

3.5 Example: Adding a Tab to Launcher

The User tab is not the only customizable tab in Launcher. To add a new tab to Launcher, create a folder
in the following directory: rti_workspace/version/user_config/launcher/panels. Name the folder with
the name you want to give the tab.

Launcher won't display the tab until you add at least one button, because Launcher doesn't show tabs that
are empty. See 3.4 Example: Adding a Button to Launcher’s User Panel on page 34.
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